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1 – INTRODUCTION

Thank  you  for  purchasing  your  Link  ElectroSystems  Ltd.  Plug-In 
Engine Control Unit (ECU).  Link G3 ECU's are an advanced, fully 
programmable microprocessor controlled Engine Management System. 
The WRXLinkG3 is the second generation of the successful  range of 
PossumLink ECU's now based on the new G3 software platform.   

The G3 software platform boasts an impressive list of features giving a 
new level of user adjustment.  This flexibility allows the tuner to have 
complete control over the engine management  system.  G3 software 
employs high resolution (up to 440 zone) fuel and ignition tables with 
configurable  load  and  RPM  centers.   When  coupled  with  four 
dimensional  fuel  and  ignition  mapping,  barometric  pressure 
compensation  and  intake  air  temperature  correction  this  gives  an 
unprecedented level of tuning accuracy.  The G3 platform also includes 
full  variable  valve  timing  (VVT)  control  and  advanced  motorsport 
features.  All G3 ECU's are in field upgradeable, there is no need to 
return the unit for software updates.

All  Link  Plug-In  Engine  Management  Systems  are  designed  with 
minimum installation in mind. Link Plug-In systems replace the circuit 
board inside the factory ECU enclosure.  This provides an unobtrusive 
means of fitting a fully programmable engine management system to 
your  vehicle  without  any permanent  modifications  and a completely 
invisible install.

Link Engine Management Systems are designed with the final result in 
mind.   Not  only do they boast  an impressive  range of  performance 
features, but are designed with a focus on safety, reliability and drive-
ability.   However,  the  ultimate  success  of  your  engine  management 
upgrade is determined by how well the system is installed and tuned.
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1.1 – LINK SUPPORT

Link  ElectroSystems  Ltd.  appreciates  your  custom  and  has  full 
confidence  that  you  will  be  satisfied  with  your  engine  management 
system upgrade.  Should any issue arise or for technical assistance the 
following support options are available:

• Contact your nearest Link Dealer (a dealer list is available on our 
website).

• Link ElectroSystems Website – www.LinkECU.com
• Technical Support Email – tech@LinkECU.com
• Online Discussion – www.LinkECU.com/forums

1.2 – SAFETY FIRST

Your Link Plug-In ECU is  designed to enhance the performance of 
your vehicle.  However in all cases, your vehicle must be operated in a 
safe manner.   Do not tune your vehicle while operating it on public 
roads.  Obey road rules at all times.

Failure to follow all installation 
and operating instructions may 

result in damage to the Link 
ECU, personal injury, or harm to 

property.
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2 – INSTALLATION

The following sections describe physical installation of the WRXLinkG3 

ECU and required sensors:

2.1 – ECU INSTALLATION

The  WRXLinkG3 is  designed  to  be  installed  in  place  of  the  printed 
circuit board in the factory ECU.  This creates a completely invisible 
install and eliminates the need to modify ECU mounting points.

WARNING
The following installation process will require handling 
of both the Link ECU and factory ECU.  Both of these 
are highly sensitive to electrostatic discharge and are 
easily  damaged.   Follow  the  anti-static  precautions 
given  in  this  manual  carefully  to  avoid  damaging 
electronic  components.   Warranty  claims  for  ECU's 
damaged  by  electrostatic  discharge  will  NOT  be 
accepted.
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ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around.  This 
charge  can  reach  very  high  voltages.   Whenever  given  the 
opportunity this  energy will  attempt  to discharge (usually through 
your finger tips!).  This can be fatal to most electronic components. 
Most people have experienced an electrostatic discharge when they 
step out of their car or touch a metal bench top.  

The following guidelines describe precautions that can be taken to 
reduce the possibility of damaging your ECU:

1. Work only on a conductive surface.  A clean steel bench is 
suitable.

2. Always wear a wrist strap that is electrically connected to the 
conductive working surface.

3. Touch the working surface regularly.

4. Do NOT touch components on the circuit board.

5. Where possible, only handle the ECU by its plastic header.

6. Do NOT carry the ECU around without static packaging (the 
black box supplied with the Link ECU is static protective).

7. Do NOT touch the bare terminals in the ECU header.

Observing  the  above  procedures  will  minimise  the  chance  of 
damaging both the factory and Link ECU's.  Note that failure due to 
static damage often does not appear until well after it was caused.
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Pre-Installation Configuration:
   A wiring change between Sti and WRX models means that the 
WRXLinkG3 must  be  pre-configured  for  your  vehicle. 
Unfortunately this wiring change is not consistent between all 
models  so  no  hard  and  fast  rule  applies  to  which  setup  is 
required.  The ECU is configured by moving the configuration 
jumpers as shown below:

Option 1

J6 – Always fitted
J2 – Fitted
J3 – Fitted

J4 – NOT Fitted
J5 – NOT Fitted

Option 2

J6 – Always fitted
J2 – NOT Fitted
J3 – NOT Fitted

J4 – Fitted
J5 – Fitted

   Do not fit the jumpers in any position other than the ones 
shown above.  No harm will be caused to the ECU by installing 
the  jumpers  in  the  wrong  option  and  fitting  the  ECU to  the 
vehicle.  If the ECU does not power up try the other jumper 
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option.  If the ECU fails to power up with the jumpers fitted in 
either of the option positions, another problem exists.

 

Installation Procedure:
1. Remove the factory ECU from the vehicle:  The factory 

ECU  is  located  on  the  passengers  side  floor  under  a 
protective  metal  plate  (under  the  carpet  where  the 
passengers  feet  would  rest).   Remove  any  necessary 
interior panels to lift the carpet to expose the metal plate 
that  covers the ECU.  Remove the 6mm bolts (10mm 
socket) that retain the metal plate and remove the plate 
from the vehicle.  Unplug the wiring harness from the 
factory ECU (press the locking button on each connector 
while  gently  pulling  on  it).   Remove  the  6mm  bolts 
(10mm socket) that retain the ECU and remove the ECU 
from the vehicle.   DO NOT touch the exposed pins in 
the factory ECU connector.

2. Remove the factory ECU from its enclosure:  Ensure you 
are following the given anti-static guidelines and ARE 
WEARING  A  CONDUCTIVE  WRIST  STRAP 
connected to the working surface.  Remove the top cover 
from the ECU enclosure by removing the five retaining 
screws.  Remove the circuit board, holding it only by the 
plastic header and place it aside.

3. Fit the Link Plug-In ECU:  Remove the Link ECU from 
its packaging and place it on the lower part of the ECU 
enclosure.  Place the factory ECU in the packaging your 
Link ECU came in for its protection.  Fit the top cover to 
the ECU enclosure.  Fit the four corner retaining screws. 
If you plan to tune the vehicle immediately, then screw 
the circuit board down without the top cover.  There will 
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be one screw left over after installation. Screw this into 
the  top  of  the  factory  ECU's  metal  heat-sink  for  safe 
keeping.

4. Fit the ECU back to the vehicle:  Fit the ECU back into 
the vehicle in the reverse order to which it was removed. 
If the top cover is not fitted, just sit it on during fitting to 
vehicle to prevent any ECU damage.

2.2 – INTAKE AIR TEMP SENSOR INSTALLATION

In  installations  where  the  Mass  Air  Flow  (MAF)  meter  is  to  be 
removed,  it  is  highly  recommended  that  an  Intake  Air  Temp (IAT) 
sensor should be installed to allow for precise fueling correction as air 
temperature changes.

Note:   Some  models  from  2003  onwards  (STI)  have  an  intake  air  
temperature sensor installed from factory in the intake manifold.  This  
sensor is wired to the ECU and connected to AN Temp 4.
Almost any NTC thermistor type  IAT sensor can be installed.   It  is 
recommended to use  a  Bosch open element IAT sensor  to  ensure a 
known  calibration  and  fast  response.   This  sensor  and  its  wiring 
connector can be purchased from any Link dealer.

Note:  Installation of the IAT sensor will require modification to the  
intake system.  A threaded boss must be welded into the intercooler or 
intake  pipes.   This  requires  correct  equipment  and  should  only  be  
performed by a professional installer.
Install the IAT sensor in the intake system between the throttle body 
and intercooler outlet.   The sensor should be installed as close as is 
practical to the throttle body.
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The IAT sensor will  be wired to the original  air  flow meter  wiring. 
IAT  sensor  wires  must  be  properly  soldered  and  insulated.   It  is 
recommended that  the IAT wires are  soldered to the air  flow meter 
wires approximately 30 mm behind the air flow meter connector.  It is 
not necessary to cut the wires, but rather strip back a 10 mm section of 
insulation.  Figure 2.2 shows wiring connections:

Figure 2.2 – WRXLinkG3 IAT Sensor Wiring Connections

After  wiring  is  completed,  it  is  essential  that  the  air  flow  meter 
connector is tied back in a manner that makes it impossible for it to be 
connected back to the air flow meter.  Connecting both the IAT Sensor 
and air flow meter could result in damage to the air flow meter and will 
result in tuning problems that could cause engine damage.
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3 – FIRST TIME SETUP

Although Link ECU's come with base settings that allow the engine to 
be started, ALL Link ECU's must be professionally tuned immediately 
after  installation.   Failing to have the ECU correctly  tuned for your 
vehicle could result in engine damage or violation of emissions laws. 

3.1 – CONNECTION TO PCLINK

PCLink  is  Link  ElectroSystems  Ltd.  ECU  tuning  software.   This 
software must be installed on a Windows based laptop/notebook before 
any adjustments  or  tuning can be performed.   The latest  version of 
PCLink is freely available for download from:

www.LinkECU.com

Link G3 ECU's come with on board USB support.  Before connecting 
your  Link  ECU  to  a  laptop/notebook  PC  for  the  first  time,  the 
communications drivers must be installed.  These drivers tell the PC 
how to talk to the ECU.  USB Drivers for Link ECU's are also freely 
available for download from the above website.

Driver  installation  instructions  are  also  available  from  the  above 
website (right next to the driver download).  These should be followed 
closely.  Should any problems arise, contact one of the support options 
given in Section 1 of this manual.

After installing both PCLink and the Link USB drivers, the ECU can be 
connected to the PC.  Connect the ECU to the PC using a standard USB 
cable (these fit most printers and are available from Link dealers) as 
shown in Figure 3.1 
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Figure 3.1 – WRXLinkG3 Tuning Cable Connection

After connecting the ECU to the PC, run PCLink.  Under the 'Options' 
menu select the correct COM port for communications with the Link 
ECU.  This COM port number should have been determined during the 
Link ECU USB driver setup.  If the COM port number is unknown, it 
may be necessary to try all COM ports until the correct one is found. 
Select 'OK' to close the 'Options' window.

To connect to the Link ECU, turn on the ignition switch then click on 
the L symbol (top center of screen).  All settings should now be loaded 
from the ECU and the Link logo in the top right corner of the screen 
should be spinning to indicate communications are OK.  If an error 
occurs during connection,  recheck all  wiring connections and ensure 
the correct COM port is selected.
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If connection can not be established, contact one of the support options 
given in Section 1 of this manual.

Help on  individual  tuning  functions  is  available  through  the 
PCLink on line help (Press F1, or right click on any item and select 
'Whats This?').  
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3.2 – INITIAL ADJUSTMENTS

It is important that the procedures described in the following sections 
are followed before the Link ECU is tuned.

3.2.1 – BASE CONFIGURATION

All WRXLink G3 ECU's are shipped with base configuration settings 
for a V7 vehicle.  PCLink includes base configurations for V7, V8 and 
V9 vehicles.  Download the appropriate base configuration into your 
ECU with PCLink by selecting 'Open' under the 'File' menu.  Select the 
appropriate  .pcl  file  and  then  select  'Open'.   Downloading  large 
configuration  files  can  take  up  to  a  few  minutes.   Be  patient  and 
acknowledge any messages the PCLink shows.

3.2.2 – MAP SENSOR CALIBRATION

The following procedure must be performed before tuning to ensure 
that the MAP Sensor is correctly calibrated.  This is done by calibrating 
the MAP sensor to the ECU's internal  Barometric Absolute Pressure 
(BAP)  sensor.   The  BAP  sensor  is  calibrated  before  the  ECU  is 
shipped.  To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to the 
ECU using PCLink as described in Section 3.1.

2. Under the 'Options' menu, select 'MAP sensor calibration'.

3. Follow the on screen instructions.

4. Select the 'Analog Inputs' tab in the runtime values section of 
PCLink (lower part of the screen).
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5. Compare  the  MAP and BAP values  and  ensure  they have a 
similar reading (within 1 kPa).

6. Perform a  'Store'  by clicking  on  the  S  button (top  center  of 
screen) and clicking OK.

3.2.4 – TPS CALIBRATION

The Throttle Position Sensor (TPS) is used by the ECU to calculate 
various engine management parameters.  It is important that the ECU 
knows when the throttle is open and closed (or part way in between). 
The following procedure calibrates the ECU to match the TPS:

1. Connect a laptop/notebook PC to the WRXLink G3 and connect 
to the ECU using PCLink as described in Section 3.1.

2. Under the 'Options' menu, select 'TPS calibration'.

3. Follow the on screen instructions.

4. Select the 'Analog Inputs' tab in the runtime values section of 
PCLink (lower part of the screen).

5. Ensure the Throttle Position value reads 0% when the throttle is 
closed and 100% when fully open.

7. Perform a  'Store'  by clicking  on  the  S  button (top  centre  of 
screen) and clicking OK.

3.2.5 – IAT SENSOR SELECTION

Where a MAF meter (Air Flow Meter) is not being used, an Intake Air 
Temperature (IAT) sensor (installed in Section 2) is used by the Link 
ECU to calculate fueling corrections based on the engines intake air 
temperature.   It  is  important  that  the  WRXLink G3 is  calibrated  to 
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match the sensor installed in the engine.  This procedure is as simple as 
selecting the correct sensor type as follows:

1. Connect a laptop/notebook PC to the WRXLink G3 and connect 
to the ECU using PCLink as described in Section 3.1.

2. Click on 'Analogue Channel'  in  the  configuration  tree  (white 
area in top left corner).

3. Click on 'ANTemp2' in the configuration tree (Note some “Spec 
C” models have an IAT sensor wired to ANTemp4).

4. Ensure 'Temp Channel #2' is set to 'Inlet Air Temperature'.

5. Select the correct 'Temp Sensor Type'.

6. Select the 'Analog Inputs' tab in the runtime values section of 
PCLink (lower part of the screen).

7. Ensure that IAT reads the correct temperature.

8. Perform a  'Store'  by clicking  on  the  S  button (top  centre  of 
screen) and clicking OK.
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4 – WRXLINKG3 EXCESS (XS) CONNECTOR

As most  of  the  WRXLink's  input  and output  pins  are  configurable, 
these pins can be used to connect other devices simply by re-wiring 
them (eg if air con is no longer fitted, the air con clutch output could be 
used to drive a shift light).

To reduce the need for modification of the factory loom, some Link 
Plug-In ECU's have a connector that allows expansion of the ECU's 
input and output capabilities.  The WRXLink's XS connector is located 
on the circuit board as shown in Figure 3.1.  This connector allows the 
following additional inputs to be connected:

● 1 x Analog Inputs – 0-5V for wide band Lambda, pressure etc...

● 2 x Digital Inputs – for switches (e.g. Antilag, launch control 
etc...)

The WRXLink's XS connector does not have any additional output pins 
as these are all used by other functions.

As  it  is  seldom used,  the  WRXLinkG3 is  not  shipped  with  the  XS 
connector wiring loom.  Contact your nearest Link dealer to purchase a 
loom.  Wiring instructions are included with the loom.

Note:
Do NOT attempt to connect anything to the WRXLink XS connector 
without using the purpose built wiring loom.  Doing so may result in 

permanent damage to your Link ECU.
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APPENDIX A – DEFAULT CONFIGURATION

The following  table  is  a  summary of  the  WRXLinkG3 input/output 
default configuration:

 Auxiliary Drivers
Aux 1 ISC Solenoid
Aux 2 VVT Solenoid (LH Inlet Cam)
Aux 3 VVT Solenoid (RH Inlet Cam)
Aux 4 Boost Control Solenoid
Aux 5 Rear Oxygen Sensor Heater
Aux 6 Tachometer
Aux 7 Engine Fan
Aux 8 Purge Solenoid

 Digital Inputs
DI 1 Vehicle Speed (Frequency)
DI 2 Cam Position (RH Inlet)
DI 3 Cam Position (LH Inlet)
DI 4 Air Con Request
DI 5 Neutral/Park
DI 6 Ignition Switch
DI 7 XS Connector
DI 8 XS Connector
DI 9 Blower Fan Switch
DI 10 IC Spray Switch
DI 11 Power Steer Switch
DI 12 Start Position

 Analog Inputs
An Temp 1 Engine Temperature
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An Temp 2 Inlet Air Temperature
An Temp 3 Fuel Temperature
An Temp 4 Intake Temp (Spec C Models)
An Volt 1 XS Connector
An Volt 2 Rear Oxygen sensor
An Volt 3 Fuel Level
An Volt 4 Fuel Tank Pressure
An Volt 5 TGV LH
An Volt 6 TGV RH
Load 1 MAP
Load 2 MAF
Load 3 TPS

 Ignition Channels
Ignition 1 Cylinder 1 Igniter
Ignition 2 Cylinder 2 Igniter
Ignition 3 Cylinder 3 Igniter
Ignition 4 Cylinder 4 Igniter
Ignition 5 Fuel Pump Relay
Ignition 6 Main Relay
Ignition 7 I/C Spray Relay
Ignition 8 Fuel Pump Speed

 Injection Channels
Injection 1 Cylinder 1 Injector
Injection 2 Cylinder 2 Injector
Injection 3 Cylinder 3 Injector
Injection 4 Cylinder 4 Injector
Injection 5 A/C Clutch Relay
Injection 6 Check Engine Light
Injection 7 Fuel Tank Pressure Solenoid
Injection 8 A/C Fan Relay
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